LEXMARK

1200 Series All-In-One

User’s Guide



Edition: February 2006

The following paragraph does not apply to any country where such provisions are inconsistent with local law: LEXMARK INTERNATIONAL, INC., PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore,
this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in
later editions. Improvements or changes in the products or the programs described may be made at any time.

Comments about this publication may be addressed to Lexmark International, Inc., Department F95/032-2, 740 West New Circle Road, Lexington, Kentucky 40550, U.S.A. In
the United Kingdom and Eire, send to Lexmark International Ltd., Marketing and Services Department, Westhorpe House, Westhorpe, Marlow Bucks SL7 3RQ. Lexmark may
use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you. To obtain additional copies of publications related
to this product, visit the Lexmark Web site at www.lexmark.com.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make these available in all countries in which it operates. Any
reference to a product, program, or service is not intended to state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification of operation in conjunction with other products, programs,
or services, except those expressly designated by the manufacturer, are the user’s responsibility.

© 2006 Lexmark International, Inc.
All rights reserved.

UNITED STATES GOVERNMENT RIGHTS
This software and any accompanying documentation provided under this agreement are commercial computer software and documentation developed exclusively at private
expense.

Safety Information
» Use only the power supply and power cord provided with this product or the manufacturer’s authorized replacement power supply and power cord.
» Connect the power supply cord to an electrical outlet that is near the product and easily accessible.

CAUTION: Do not set up this product or make any electrical or cabling connections, such as the power supply cord or telephone, during a lightning storm.

» Refer service or repairs, other than those described in the operating instructions, to a professional service person.
* This product is designed, tested, and approved to meet strict global safety standards with the use of specific Lexmark components. The safety features of some parts may
not always be obvious. Lexmark is not responsible for the use of other replacement parts.



Contents
Finding more information ........ccccceevviiiiiiiinnieennnes 4
Learning about the All-In-One ...........cooeiiiiiiiinnnne 4
Setting up the All-IN-0ne ... 4
Understanding the parts of the All-In-One .................. 4
Using the control panel ........ccccoooeviiiiiiiiiiiiiies 5
Understanding the software ...........cccooeeeviiieennnnnn. 5
Using the Lexmark All-In-One Center .........ccccceeeeennn. 5
Using Print Properties .......cccceeeeiiiiiiieeeeiiiiiceeeenn 7
Using the Lexmark Solution Center ...............c.ouuuueees 8
Using the Lexmark Photo Editor ..............ccceevvvvvvnnnnens 9
Using the All-IN-0ONe ..o, 9
o 11011 T S 9
SCANNING ceeiieiiitiie e 11
(670] o)/ 1o o [P TURPRPP 12
= V(] o 12
Creating fun Projects .........oovvvevviiiiviiiiiiieeee e 13
Replacing print cartridges .........coooeeeeiiiiiiieiiiiiiiinnnnns 13
Troubleshooting ......ooiiiiiiii 14
Troubleshooting checklist ...........cccceeiiiiiiiiiiiiiiiiiiis 14
Setup troubleshooting .........cccovvvvvviiiiiiiiie e 14

Printing troubleshooting ..., 15

Scanning, copying, and faxing troubleshooting ........ 16

Removing and reinstalling the software .................... 16
NOTICES i 17
INAEX e 19

ysiibu3



Finding more information

Learning about the All-In-One

Resource  Description

Setup sheet Instructions on how to set up the hardware and software and
information on setup troubleshooting

CD » Software for the All-In-One, including:

— Lexmark All-In-One Center
— Lexmark Photo Editor
— Print Properties
— Lexmark Solution Center
¢ Dirivers for the All-In-One
« An online User’s Guide for basic usage information

* A Readme file

This file provides last-minute updates about technical
changes to the All-In-One. To access the Readme file after
you install the All-In-One software, click Start >
Programs = Lexmark 1200 Series = Readme.

Lexmark Web | http://support.lexmark.com
site Information on:
« Upgrades—Software upgrade information

e Customer Support—Contact information, order status, and
warranty

» Downloads—Drivers
» Solutions—Troubleshooting hints and tips

* Reference—Product documentation and product
specifications

Setting up the All-In-One

If you have not already done so, follow the steps on the Setup Sheet to complete
the hardware and software installation. If problems occur during the setup
process, see “Setup troubleshooting” on page 14.

Understanding the parts of the All-In-One

Pe.lper guide Paper support
Slide next to paper_to Lift to load paper into the
ensure proper feeding. All-In-One

Control panel

Use the buttons to operate the
All-In-One.

Scanner unit
Lift to access the print
cartridges.

Top cover
Lift to place an item on
the scanner glass.

Paper exit tray
Extend to hold paper as it
exits the All-In-One.


http://support.lexmark.com

USB cable /

Power cord

Using the control panel

The All-In-One has a control panel that lets you scan and copy with the press of
a button.

Note: Both the computer and the All-In-One must be turned on to make
copies.

Understanding the software

The All-In-One software consists of four main components:

The Lexmark 1200 Series All-In-One Center (scanning, copying, and faxing)
Print Properties (printing)

The Lexmark Solution Center (troubleshooting, maintenance, and cartridge
ordering information)

The Lexmark Photo Editor (editing graphics)

Using the Lexmark All-In-One Center

Use the Lexmark 1200 Series All-In-One Center software to scan, copy, and fax
documents.There are three ways to open the All-In-One Center:

Click Start » Programs » Lexmark 1200 Series » Lexmark All-In-
One Center.

Double-click the Lexmark 1200 Series All-In-One Center icon on the
desktop.

Press Scan on the control panel. For more information about using the
control panel, see page 5.

The All-In-One Main Page appears.

All-In-One Center
All-In-One Main Page
Preview
section a

» “%) Allin-One Main Page

) View Saved Inages
\ 7, MenianTioubieshoot

Preview Now

- L~ Scan Now

- /Copy Now

Creative Tasks

| —
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The All-In-One Main Page

The All-In-One Main Page consists of four main sections: Scan, Copy, Creative
Tasks, and Preview.

From this section: You can:

View Saved Images page

Use the View Saved Images page to perform tasks with images that are saved
on the computer. The View Saved Images page consists of three sections.

You can:

From this section:

Scan « Select a program to send the scanned image to.
« Choose what type of image is being scanned.
» Choose how the scan will be used.

Note: Click See More Scan Settings to view all
settings.

Copy « Select the quantity and color of your copies.
« Select a quality setting for your copies.

« Adjust the size of the scanned area.

« Lighten or darken your copies.

« Enlarge or reduce your copies.

Note: Click See More Copy Settings to view all
settings.

Creative Tasks Choose from a variety of creative ideas.

Enlarge or reduce an image.

Repeat an image several times on one page.
Print an image as a multiple-page poster.
E-mail an image to a friend.

Fax using your PC’s modem.

Save an image or document.

Edit text found in a scanned document (OCR).
Modify an image with a photo editor.

Preview section « Select a region of the preview image to scan.
» View an image of what will be printed or
copied.

Note: For more information about the All-In-One Main Page, click the Help
button located in the upper right corner of the screen.

Open with... Select a program to send the saved image to.

Print a Copy... « Choose the quantity and color of your copies.
« Select a quality setting for your copies.

¢ Lighten or darken your copies.

« Enlarge of reduce your copies.

Note: Click See More Copy Settings to view all
settings.

Creative Tasks Select from a variety of creative ideas. For more

information, see page 6.

Note: For more information about this page, click the Help button located
in the upper right corner of the screen.

Maintain/Troubleshoot page

The Maintain/Troubleshoot page provides you with direct links to the Lexmark
Solution Center. Choose from these topics:

* Maintain or fix quality problems

» Troubleshoot All-In-One problems

» Device status and ink levels

* More printing ideas and how to’s

e Contact information

* Advanced (Skin, voice, and communication options)
* View the software version and copyright information

For more information about the Lexmark Solution Center, see page 8.

Note: For more information about this page, click the Help button located
in the upper right corner of the screen.



Using Print Properties

Print Properties is the software that controls the All-In-One printing function. You
can change the settings in Print Properties based on the type of project you want
to create. You can open Print Properties from almost any program:

1 From the program File menu, click Print.

2 In the Print dialog box, click Properties, Preferences, Options, or Setup
(depending on the program).
The Print Properties screen appears.

Note: Some programs open Print Properties differently.
Print Properties
Quality Copies tab and | Want To menu

“I Want To”
Print Properties 1] menu
tabS _ Save Selings ~ 1'Want Ta « Options ~ Se|eCt One Of the

Use the Qual |ty/ Quality/Copies.
Copies, Paper

Setup, and

projects from the
menuto help print
photos, banners,

Print Layout tabs envelopes,
to select the print posters, and
settings. more.

Pt Co
| T Black an

pal
)

The “1 Want To” menu

The “I Want To” menu appears when you open Print Properties. It contains a
variety of task wizards to help you select the correct print settings for your project.
Close the menu for a full view of the Print Properties dialog box.

Print Properties tabs

All of the print settings are on the three main tabs of the Print Properties software:
Quality/Copies, Paper Setup, and Print Layout.

From this tab:  You can change these settings:

Quality/Copies Quality/Speed — Select a Quality/Speed setting.
Multiple Copies — Customize how the All-In-One prints
several copies of a single print job, collated or normal.

Print Color Images in Black and White — Select this to
print color images in black and white.

Paper Setup Type — Select the type of paper you are using.
Paper Size — Select the size of the paper you are using.

Orientation — Select how you want the document
oriented on the printed page. You can print portrait or
landscape.

Print Layout Layout — Select the layout you want to print.

Duplexing — Select this when you want to print on both
sides of the paper.

Note: For additional information about these settings, right-click a setting
on the screen, and then select the What’s This? item.

Save Settings menu

From the Save Settings menu, you can name and save the current Print
Properties settings for future use. You can save up to five custom settings.

Options menu

Use the Options menu to make changes to the Quality Options, Layout Options,
and Printing Status Options settings. For more information on these settings,
open the tab dialog box from the menu, and then click the Help button on the
dialog box.

The Options menu also provides you with direct links to different parts of the
Lexmark Solution Center (see page 8), as well as software version information.
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Using the Lexmark Solution Center

The Lexmark 1200 Series Solution Center is a valuable information resource. To
open the Lexmark Solution Center, click Start » Programs » Lexmark 1200
Series » Lexmark 1200 Series Solution Center.

From this tab: You can:

Maintenance ¢ Install a new print cartridge.

Note: Wait until scanning is complete before installing
new cartridges.
The Printer Status tab appeatrs. « View shopping options for new cartridges.

RiEES Printer Stat * Print a test page.
e rinter status + Clean to fix horizontal streaks.
r

e S olon ol ¢ Align to fix blurry edges.
o * Troubleshoot other ink problems.

¢ Remove Japanese postcard residue.
Ink levels

Contact « Learn how to contact Lexmark by phone, e-mail, or on
Information the World Wide Web.

Advanced * Change the appearance of the Printing Status window
and turn printing voice notification on or off.

The Lexmark Solution Center consists of six tabs: Printer Status, How To, » Change the network settings for the printer.
Troubleshooting, Maintenance, Contact Information, and Advanced. « Obtain software version information.

From this tab: You can:

\ Find out more about Lexmark oniine
st the home page now.

Note: For more information, click the Help button located in the lower right
corner of the screen.

Printer Status
(Main dialog box)

« View the status of the All-In-One. For example, while
printing, the status is Busy Printing.
« View the ink levels of the print cartridges.

How To

Learn how to:

Scan, copy, fax, and print.

Find and change settings.

Use basic features.

Print projects such as banners and iron-on
transfers.

Troubleshooting

« Learn tips about the current status.
* Solve All-In-One problems.




Using the Lexmark Photo Editor

Use the Lexmark Photo Editor software to edit graphics. To open the Lexmark

Photo Editor, click Start » Programs » Lexmark 1200 Series » Lexmark
Photo Editor.

The Lexmark Photo Editor displays.
Use the touch-up tools to edit your graphic.

Note: Move your pointer over the tool for a description.

Touch-up tools

Using the All-In-One

The following sections give you everything you need to know for basic printing,
scanning, copying, and faxing.

Printing

The Print Properties “I Want To” menu (see page 7) provides you with printing
wizards to help you complete tasks such as printing banners, photographs, or
posters.

1 Depending on what you want to print, load the appropriate type of paper into
the All-In-One. Place the paper against the right side of the paper support

with the print side facing you. Make sure you select the paper size for your
document. For more information, see page 10.

F——

Load up to:
» 100 sheets of plain paper
* 25 sheets of labels
¢ 25 iron-on transfers
« 25 sheets of photo/glossy paper

¢ 10 transparencies

Note: Since transparencies and
photos require more drying time, we
recommend that you remove each
transparency or photo as it exits and
allow to dry to avoid ink smearing.

3
/

20 sheets of banner paper

10 sheets of greeting card stock

10 Hagaki cards

10 envelopes

Note: Do not load envelopes with:

Holes, perforations, cutouts, or
deep embossing

Metal clasps, string ties, or
metal folding bars

Exposed flap adhesive
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2 Squeeze and slide the paper guide to the left edge of the paper. To see details about a setting, right-click a setting on the screen, and then
select the What's This? item.

Paper size
|l ——setting

a Po 46
0 44 210297 )
2 85 (1821257 ) L
3 45 (1485210 )

5 Stsement (51/2181/2in)

e | L Orientation
——— 7 .
L anoope setting
oK Cancel Heb

9 From the Print Layout tab, select the layout and duplexing settings for the
type of document you are printing.

To see details about a setting, right-click a setting on the screen, and then
select the What's This? item.

3 Make sure the All-In-One is turned on. -
. : . Layout
4 Click File » Print. — : ~ || —setting
5 From Print dialog box, click Properties, Preferences, Options, or Setup Come e 5 1
. i MY e
(depending on the program). ',.., 0 - Duplexing
The Print Properties dialog box appears. e o ——setling
6 If the printing task you want to perform is on the “I Want To” menu, click it, \f - -
and then follow the instructions on the computer screen; otherwise, click
LEXMARK ok | coed | hen |

Close at the bottom of the menu.
7 From the Quality/Copies tab, select the quality, speed, and copy settings.

To see details about a setting, right-click a setting on the screen, and then
select the What's This? item.

10 Once you have applied all the settings you want in Print Properties, click OK
at the bottom of the screen to return to the Print dialog box.

11 Click Print to complete your task.

Copy

Quality/Speed ||
7 settings

settings

8 From the Paper Setup tab, select the paper type, paper size, and orientation.
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SC ann | n g From the “Send scanned image to” drop-down menu, select a program to
send the scanned image to, or click the Creative Tasks section to display a

The following steps show you how to scan and save images. list of projects.

== Preview Now button

S p— Click to see a preview
0 Heintain/ Troubleshoot r”t Previe wc.w/d( I )
of the image.

1 Open the top cover of the All-In-One.

2 Place the item you want to scan facedown on the glass. Make sure the
upper left corner of the front of the item aligns with the arrow

Scan Now button
Click to scan the item
on the scanner bed.

T
¥}
a8
i0F g
i
i
e}

A

_+ Copy now settings

/ u Adjust the settings for
the scanned item.
et 1 | Creative Tasks
s iy ] | Choose what you

want to do with the
scanned item.

Preview section
See a preview of the image, and select an area to be scanned.

9 If you are sending the scanned image to a software program, click Scan
Now to complete the scan. If you are using the Creative Tasks section,
follow the instructions on the computer screen.

3 Close the top cover.
4 Open the Lexmark All-In-One Center (see page 5).

The All-In-One Main Page appears. , i i i
For a list of the Creative Tasks available from the All-In-One Main Page, see
5 Click Preview Now located in the upper right corner of the All-In-One Main page 6.
Page.

An image of the scanned item appears in the preview section.
6 Click and drag to select a specific area of the preview image to scan.
7 Click See More Scan Settings to review and change the scan settings.
8 Select your scan settings.

11
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Copying
Note: You can make a color or black-and-white copy. Press Color Copy or
Black Copy on the control panel.

To make black-and-white, gray, or color copies:

1 Open the top cover of the All-In-One.

2 Place the item you want to copy facedown on the glass. Make sure the upper
left corner of the front of the item aligns with the arrow.

3 Close the top cover.
4 Open the Lexmark All-In-One Center (see page 5).

The All-In-One Main Page appears.
5 Click See More Copy Settings to review and change the copy settings.
The All-In-One Copy section expands:

® == ==, Preview Now button
) ) Allin-One Main Page J— [r . . .
Ciersemions r— Click to see a preview of the image.
20, Maintain/Troubleshoot jven o
| Copy Now button
Corr Click to copy your image.
[
=] l:i\m?hala = _E”L""_J
f—
€ GQuickCopy. .
& Mo Copy settings
© Best — . .
/ ! Adjust the settings for the copy.
— o = @s-a0%

Preview section
See a preview of the image, and
select an area to be copied.

6 Select your copy settings.

Note: You may want to reduce or enlarge the image.

12

7 Click Copy Now.

Faxing

The following steps tell you how to send a fax using the computer modem.
1 Open the top cover.

2 Place the item you want to fax facedown on the glass. Make sure the upper
left corner of the front of the item aligns with the arrow.

3 Close the top cover.
4 Open the Lexmark All-In-One Center (see page 5).

5 From the Creative Tasks section of the All-In-One Main Page, click Fax an
image.

6 Follow the instructions on the computer screen.



Creating fun projects

To create these and other fun projects:

1 Open the Lexmark Solution Center (see page 8).
2 Click How To.

3 Select a project.

4 Follow the instructions on the computer screen.

Replacing print cartridges

The Lexmark 1200 Series uses the following cartridges:

Item: Part number:

Black cartridge 10N0016 16 17

Color cartridge 10N0026 26 27

Note: Forinformation about ordering supplies, see the Maintenance tab on
page 8.

13

1 Make sure the All-In-One is on.

2 Lift the scanner unit until the scanner support keeps it open.
The print cartridge carrier moves and stops at the loading position unless
the All-In-One is busy.

3 Grasp the tabs on the cartridge lids, and then lift the lids.

4 Remove the old cartridges. Store them in an air-tight container or dispose
of them.

5 If you are installing new cartridges, remove the stickers and transparent
tape from the bottom of the cartridges.

Warning: Do not touch the gold contact area on the cartridges.

6 Insert the new cartridges. Make sure the black print cartridge is secure in
the right carrier and the color cartridge is secure in the left carrier, and then
snhap the lids closed.

7 Lift the scanner unit and push the scanner support back while lowering the
scanner unit until it is completely closed.

Lexmark’s All-In-One warranty does not cover repair of failures or damage
caused by a refilled cartridge. We do not recommend use of refilled cartridges.
Refilling cartridges can affect print quality and cause damage to the All-In-One.
For best results, use Lexmark supplies.

ysiibu3



Setup troubleshooting

Problem: Go to page:

Troubleshooting

This section helps you solve problems you may have with the All-In-One.

Additional troubleshooting information is available in the Lexmark Solution

Center. For help accessing the Lexmark Solution Center, see page 8. Power light does not come on 14
Alignment page does not print 14
TI‘O u b I es h 0) Ot| n g C h ecC kl |St When | insert the All-In-One software CD, nothing 15
. happens
Before you try to solve the problem, check the following: PP
All-In-One is not communicating with the computer 15
Is the power cord firmly attached to the All-In-One and a known
E working electrical outlet? Installation appears incomplete 15
All-In-One prints slowly 15
-In- 2
E Are both the computer and All-In-One turned on~ Print is too dark or smudged 15
Vertical lines are jagged or edges are not smooth 15
Is the USB cable securely attached to the computer and the All- 1ag9 g
E In-One? White lines appear in graphics or solid black areas 15
Did you remove the sticker and transparent tape from both print All-In-One has a paper jam 16
E cartridges? For help, refer to the setup documentation. Scanning was not successful 16
Is the black print cartridge secure in the right carrier and the color Scanning or using a scanned image with a software 16
E cartridge secure in the left carrier? program takes a long time or freezes the computer
Edge of the copy does not print 16
Is the paper loaded correctly? Make sure you do not force the
E[ paper into the printer. Copy button on the control panel does not work 16
] ] ] Fax function does not work 16
Did you install the printer software correctly? For help, refer to the

EENEY

setup documentation.

Is the Lexmark 1200 Series set as the default printer? To check,
click Start » Settings » Printers. If the Lexmark 1200 Series is
not set as the default printer, you need to remove and then
reinstall the software. For help, see page 16.

Power light does not come on

1 Check the power cord connections.
2 Press Power on the control panel.

Alignment page does not print

1 Make sure you remove the sticker and transparent tape from both print
cartridges. For help installing print cartridges, refer to the setup
documentation.

2 Make sure the black print cartridge is secure in the right carrier and the color
cartridge is secure in the left carrier.

14



3 Make sure you loaded the paper correctly and did not force the paper into
the All-In-One.

When | insert the All-In-One software CD, nothing
happens

From the Desktop, double-click the My Computer icon, and then double-click the
CD-ROM drive icon.

All-In-One is not communicating with the computer

1 Disconnect and reconnect both ends of the USB cable. For help, refer to the
setup documentation.

2 Unplug the power cord from the electrical wall outlet, plug it back in, and
then press Power. For more information, refer to the setup documentation.

3 Restart the computer. If the problem continues, remove and then reinstall
the software. For more information, see page 16.

Installation appears incomplete
The software may not be installed properly. Try the following:
1 Right-click the My computer icon.

For Windows XP, click Start to access the My computer icon.

N

Click Properties.
3 For Windows 98 or Windows Me, click the Device Manager tab.

For Windows 2000 or Windows XP, select the Hardware tab, and then click
the Device Manager button.

4 Look for the Other Devices category. If there are any Lexmark devices
shown here, highlight them and, then press the Delete key.

Note: The Other Devices category appears only when unknown devices
are present. Do not delete any Lexmark items unless they are
present under the Other Devices category.

5 Insert the CD, and install the software again. Do not restart the computer.
For help, refer to the setup documentation.

15

Printing troubleshooting

All-In-One prints slowly
1 Close all programs not in use. The memory resources may be low.

2 Make sure the Print Properties Quality/Speed setting is set on Normal or
Quick Print. For more information, see page 7.

3 Try printing a smaller file. If the memory resources are too low, you may not
be able to print larger files. Consider purchasing more memory.

Note: Photographs typically have a larger file size. Try lowering the
scanning resolution.

Print is too dark or smudged
1 Remove the paper as it exits. Let the ink dry before handling.

2 Adjust the Quality/Speed setting in Print Properties or in the All-In-One
Center. For more information, see page 7 or page 6.

The Better or Best Quality/Speed setting may cause smearing if used with
plain paper. Try using Normal.

3 Open the Lexmark Solution Center (see page 8).
4 From the Maintenance tab, click Clean to fix horizontal streaks.

Vertical lines are jagged or edges are not smooth

1 Adjust the Quality/Speed setting in Print Properties. For help, see page 7.
For best print quality, select Better or Best.

2 Align the print cartridges. To align the print cartridges:
a Open the Lexmark Solution Center (see page 8).
b From the Maintenance tab, click Align to fix blurry edges.

White lines appear in graphics or solid black areas

Clean the print cartridge nozzles. Going long periods without using the All-In-
One can cause the print cartridge nozzles to become clogged. To clean the
cartridge nozzles:

1 Open the Lexmark Solution Center (see page 8).

2 From the Maintenance tab, click Clean to fix horizontal streaks.

ysiibu3



All-In-One has a paper jam
1 Follow the instructions on the screen for clearing the paper jam.

2 Make sure you are using paper designed for an inkjet printer. For a list of
recommended papers, see page 9.

3 Make sure you are loading the paper correctly. For more information, see
page 10.

4 Make sure the paper guide is against the left edge of the paper. For more
information, see page 10.

Scanning, copying, and faxing
troubleshooting

Scanning was not successful

The software may not be installed properly. Follow the instructions for “All-In-One
is not communicating with the computer” on page 15.

Scanning or using a scanned image with a software
program takes a long time or freezes the computer
Lower the scanning resolution. Scanning resolution is much different than
printing resolution and is generally set much lower. To change the scanning
resolution:

1 Open the Lexmark All-In-One Center. For help, see page 5.

2 From the Scan section, click See More Scan Settings.

3 Click Display Advanced Scan Settings.

4 From the Scan tab of Advanced Scan Settings, enter a lower scan
resolution.

Edge of the copy does not print

* Make sure the original item is properly oriented on the glass. For more
information, see page 11.

¢ Make sure the area you want to copy is not larger than the printable area of
the page. Apply the Fit-to-page feature. To apply the Fit-to-page feature:

1 Open the Lexmark All-In-One Center (see page 5).
2 From the Copy section, click See More Copy Settings.

16

3 From the Reduce/Enlarge section, click the second button, and then select
Fit to page from the corresponding drop-down menu.

4 Copy your document again.

Copy button on the control panel does not work

* Make sure the computer is on. The computer must be on in order for the All-
In-One to work.

* Make sure you properly installed the software. For help, refer to the setup
documentation. The software must be installed for the copier to work.

Fax function does not work
* Make sure the computer and the All-In-One are on.

* Make sure the computer is connected to a phone line. A phone connection
is required for faxing to function.

* The memory may be full. Wait until the faxes in memory have been sent, and
then send the current fax again.

Removing and reinstalling the software

If the All-In-One software is not functioning properly or a communications error
message appears when you try to use the All-In-One, you may need to remove,
and then reinstall the printer software.

1 From the desktop, click Start » Programs » Lexmark 1200 Series »
Uninstall Lexmark 1200 Series.

Note: If Uninstall is not an option on the menu, see “All-In-One is not

communicating with the computer” on page 15.
2 Follow the instructions on the computer screen to remove the All-In-One
software.
3 Restart the computer before reinstalling the software.

4 Insert the CD and follow the instructions on the computer screen to install
the software. For help, refer to the setup documentation.



Notices

The following information applies to all notices for this product:

Lexmark 1200 Series

Product name

4476-005
4476-006
4476-007
4476-008

Machine type

Electronic emission notices

Federal Communications Commission (FCC) compliance information
statement

This product has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may
not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.
The FCC Class B limits are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
. Reorient or relocate the receiving antenna.
. Increase the separation between the equipment and receiver.
. Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected.
. Consult your point of purchase or service representative for additional suggestions.
The manufacturer is not responsible for any radio or television interference caused by using other
than recommended cables or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate this equipment.
Note: To assure compliance with FCC regulations on electromagnetic interference
for a Class B computing device, use a properly shielded and grounded cable
such as Lexmark part number 1021294. Use of a substitute cable not properly
shielded and grounded may result in a violation of FCC regulations.
Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.

740 West New Circle Road

Lexington, KY 40550

(859) 232-3000
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Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing
Equipment Regulations.

Avis de conformité aux normes de I'industrie du Canada

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement sur le matériel
brouilleur du Canada.

European Community (EC) directives conformity

A declaration of conformity with the requirements of the directives has been signed by the Director of
Manufacturing and Technical Support, Lexmark International, S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.
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Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance
with ISO 9296:

1-meter average sound pressure, dBA

Printing 44
Scanning 38
Copying 44
Idling 0

Values are subject to change. See www.lexmark.com for current values.

ENERGY STAR

ENERGY STAR

Waste from Electrical and Electronic Equipment (WEEE) directive

|5
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Index

A

Advanced tab 8
All-In-One Center, see Lexmark All-In-One
Center
All-In-One Main Page
Copy section 6
Creative Tasks section 6
Preview section 6
Scan section 6
All-In-One status 8

B

banner
printing 7
banner paper 9
banners
printing 7
black and white, printing in 7
both sides, printing on, see duplexing

C

card stock 9
cartridges
part numbers 13
viewing ink levels of 8
Contact Information tab 8
control panel 5
copies 7
copy settings 6
copying 12

D
duplexing 7

E

electronic emission statement 17
emission statement 17
envelopes

printing 7

F

faxing 12
FCC statement 17

G
glossy paper 9

H

hardware setup
software setup 4
How To tab 8

| Want To
change quality settings 7
change speed settings 7
print a banner 7
print a photo 7
print a poster 7
print an envelope 7
print on both sides of the paper 7
see more printing ideas 7
| Want To menu 7
ink cartridges
viewing ink levels of 8
ink levels
viewing 8
inkjet paper 9
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iron-on transfers 9
printing 7

L

labels 9

Lexmark All-In-One Center 5
opening 5
using 5

Lexmark Solution Center 8
Advanced tab 8
Contact Information tab 8
How To tab 8
Maintenance tab 8
opening 8
Printer Status tab 8
Troubleshooting tab 8

loading paper 9

ysiibu3

M

Maintain/Troubleshoot page 6
Maintenance tab 8
multiple copies 7

O

orientation, selecting 7

P
paper
acceptable types of 9
loading 9
paper exit tray 4
paper guide
adjusting 10
Paper Setup tab 7



parts of your All-In-One 4
photo paper 9
photos
printing 7
scanning 11
poor quality printing 15
posters
printing 7
Preview Now button 11
Preview section
Preview Now button 11
Print/Copy preview 6
Scan preview 6
print cartridges
viewing ink levels of 8
Print Layout tab 7
Print Properties 7
| Want To menu 7
opening 7
Options menu 7
Paper Setup tab 7
Print Layout tab 7
Quality/Copies tab 7
Save Settings menu 7
tabs 7
printing 9
banners 7
envelopes 7
photos 7
posters 7
Printing Status window
changing appearance of 8

Q

Quality/Copies tab 7

R

reinstalling software 16
removing software 16

replacing print cartridges 13

S

Save Settings menu 7

saved images
viewing 6

scan settings 6

scanner unit 4

scanning 11

placing an item on the glass 11
settings, saving for future use 7

setup 4
software
reinstalling 16
removing 16
sound, see voice notification
Status tab 8

T

top cover 4
transparencies 9
troubleshooting
copying problems 16
faxing problems 16
scanning problems 16
troubleshooting checklist 14
Troubleshooting tab 8

Vv

View Saved Images page 6
Open with... section 6
Print a Copy...section 6

voice notification
turning on or off 8
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